Connected Components Workbench 9.0 release notes

The release notes for Connected Components Workbench 9.00 contain the following information:

Legal Notices
Support Information
New Features and Enhancements
System Requirements
Working with Projects in Connected Components Workbench
Installation and Upgrades
Helpful Resources
Important Considerations
Resolved Anomalies
Known Anomalies
Application Notes

Legal Notices

Copyright notice

© 2015 Rockwell Automation, Inc. All rights reserved. Printed in USA.

This document and any accompanying Rockwell Software products are copyrighted by Rockwell Automation, Inc. Any reproduction and/or distribution without prior written consent from Rockwell Automation, Inc. is strictly prohibited. Please refer to the license agreement for details.

End User License Agreement (EULA)

You can view the Rockwell Automation End-User License Agreement ("EULA") by opening the License.rtf file located in your product's install folder on your hard drive.
Trademark Notices

Allen-Bradley, ControlLogix, CompactLogix, Connected Components Workbench, FactoryTalk, Guardmaster, Kinetix, Micro800, MicroLogix, MicroLogix to Micro800 Conversion Tool, PowerFlex, PanelView, PanelView Plus, PLC-2, PLC-3, PLC-5, Rockwell Automation, and Rockwell Software are trademarks of Rockwell Automation, Inc.

Any Rockwell Automation software or hardware not mentioned here is also a trademark, registered or otherwise, of Rockwell Automation, Inc.

Other Trademarks

Microsoft, Excel, Visual C++, SQL Server and Visual Studio are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Adobe, Reader, and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. OPC is either a registered trademark or trademark of OPC Foundation in the United States and/or other countries. Kepware is either a registered trademark or trademark of Kepware Technologies Corporation in the United States and/or other countries. All other trademarks are the property of their respective holders and are hereby acknowledged.

Warranty

This product is warranted in accordance with the product license. The product’s performance may be affected by system configuration, the application being performed, operator control, maintenance, and other related factors. Rockwell Automation is not responsible for these intervening factors. The instructions in this document do not cover all the details or variations in the equipment, procedure, or process described, nor do they provide directions for meeting every possible contingency during installation, operation, or maintenance. This product’s implementation may vary among users.

This document is current as of the time of release of the product; however, the accompanying software may have changed since the release. Rockwell Automation, Inc. reserves the right to change any information contained in this document or the software at any time without prior notice. It is your responsibility to obtain the most current information available from Rockwell when installing or using this product.

Environmental compliance


Contact Rockwell

Customer Support Telephone — 1.440.646.3434
Online Support — http://www.rockwellautomation.com/support/
Support Information

To access Live Chat

From Rockwell Automation Support, click Get Support Now and use Live Chat which is available without requiring a TechConnect Support contract for Connected Components Workbench and Micro800 controllers. Member login is required. Go to: http://www.rockwellautomation.com to register.

Additional support options are available from the Help menu, see Helpful Resources.

New Features and Enhancements

Workbench - Add Device

Use the Add Device dialog box to add devices to the Connected Components Workbench project using textual descriptions of the specifications.

To open Add Device dialog box

- From the File menu, click Add Device.
- From Project Organizer, click the Add Device icon.

Workbench – Selective Install

Installation now has options to only install the required devices to shorten installation time and reduce required hard drive space. Additional devices can be installed later by re-executing setup.exe.

Workbench – Uninstall Utility

Uninstall utility is available to aid in uninstalling software components.
Workbench - Usability Enhancements

This release includes the following usability enhancements.

<table>
<thead>
<tr>
<th>Interface Element</th>
<th>Description of Updates Since Previous Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows and dialog boxes</td>
<td></td>
</tr>
<tr>
<td>Connected Components Workbench Toolbar</td>
<td>The Toolbar has new icons for Micro800 Run Mode Change. They are:</td>
</tr>
<tr>
<td></td>
<td>• Run Mode Change</td>
</tr>
<tr>
<td></td>
<td>• Test changes</td>
</tr>
<tr>
<td></td>
<td>• Accept changes</td>
</tr>
<tr>
<td></td>
<td>• Discard unaccepted changes</td>
</tr>
<tr>
<td></td>
<td>The Toolbar has new icons for Micro800 controllers. They are:</td>
</tr>
<tr>
<td></td>
<td>• Connect, Disconnect, Connected, Disconnected</td>
</tr>
<tr>
<td></td>
<td>• Build</td>
</tr>
<tr>
<td></td>
<td>• Download</td>
</tr>
<tr>
<td></td>
<td>• Upload</td>
</tr>
<tr>
<td>Project Organizer</td>
<td>The following icons have been added to the Project Organizer:</td>
</tr>
<tr>
<td></td>
<td>• Add device to the project</td>
</tr>
<tr>
<td></td>
<td>• Remove selected device from the project</td>
</tr>
<tr>
<td></td>
<td>• Discover device from connection browser</td>
</tr>
<tr>
<td>View Menu</td>
<td>The View menu has a new menu item:</td>
</tr>
<tr>
<td></td>
<td>• Unused Variable Browser</td>
</tr>
<tr>
<td>Device Menu</td>
<td>The Device menu contains the following new item for Micro800 controllers:</td>
</tr>
<tr>
<td></td>
<td>• Setup Connection Path – used to remember previous connection paths</td>
</tr>
<tr>
<td>Upload</td>
<td>When uploading the project from a Micro820, Micro830, or Micro850 controller, a new Upload Confirmation dialog appears, asking if you wish to Upload or Upload with Logical Values.</td>
</tr>
<tr>
<td>Micro800 Controller Configuration pages</td>
<td>The Micro800 Controller Configuration pages with changes:</td>
</tr>
<tr>
<td></td>
<td>• Memory</td>
</tr>
<tr>
<td></td>
<td>• Serial Port</td>
</tr>
<tr>
<td>Cross Reference Browser</td>
<td>The Cross Reference Browser enhancements include a new interface and improved access to variables.</td>
</tr>
<tr>
<td>Toolbox</td>
<td>By default, the Toolbox now opens (unpinned) and covers part of the workspace.</td>
</tr>
<tr>
<td></td>
<td>To reset the Toolbox so it does not cover the workspace, click the Auto Hide icon found in the top right corner of the Toolbox.</td>
</tr>
</tbody>
</table>

Micro800 - Socket support for Micro800 controllers

Socket Instructions are supported by Micro820 and Micro850 controllers and support full duplex communication with remote devices.

Sockets protocol is used for Ethernet communications to devices which do not support Modbus TCP and Ethernet/IP. Sockets support client and server and TCP and UDP. Typical applications include communicating to printers, bar codes readers, and PCs.

Socket instructions
- SOCKET_ACCEPT
- SOCKET_CREATE
- SOCKET_DELETE
- SOCKET_READ
- SOCKET_WRITE
- SOCKET_INFO
- SOCKET_OPEN

The Communication Diagnostic View, Ethernet now supports the User Programmed Socket protocol. The User Programmed Socket protocol monitors socket statistics for Micro820 and Micro850 controllers at version 9 or higher.
To open the Ethernet Diagnostics - User Programmed Socket protocol

1. Connect to the controller.

2. Perform one of the following actions:
   - From the Device menu, select Diagnose, then click Communication.
   - From the Controller toolbar, click Diagnose, then click Communication.
   - From the Controller - Ethernet view, click Diagnose.

3. From the Communication Diagnostic View, for Communication select Ethernet.

4. For Protocol select User Programmed Sockets.

Micro800 - Bit shift array element support for Micro800 controllers

Bit Shift Instructions are supported by Micro820, Micro830, and Micro850 controllers and are used to shift a bit in an array element to the right or left.

**Bit shift instructions:**
- BSL
- BSR

Micro800 - Upload project without updating controller module configuration

Micro800 Upload has been modified and is no longer the same as Discover. Upload only uploads the downloaded project and requires that the controller catalog in the project organizer matches the online controller. Upload should typically be used to upload the project in the controller without changing the project’s Plugin and Expansion I/O module configuration.

Micro800 - Unused Variable Browser

The Unused Variable Browser is used to view user-defined variables that are unassigned to a Micro800 controller program.
To access the Unused Variable Browser

- From the View menu, select Unused Variable Browser.
- From the Cross Reference Browser, click (# unused Variables).

**Micro800 - Setup Connection Path**

The Setup Connection Path dialog box is used to define the connection path for Micro800 controllers for online connections. It is no longer necessary to always select the connection path for download and upload.

To access the Setup Connection Path dialog box

- From the Device menu, select Setup Connection Path.
- From the Controller header, click the Setup connection path icon.

**Micro800 - Module Profile Tool**

The Module Profile Tool is used to import additional 2085 Expansion I/O module profiles into Connected Components Workbench projects.

To access the Module Profile Tool

- From the Tools menu, select Module Profile Tool.

**440C-CR30 - Enhancements**

The Guardmaster 440C-CR30 Safety Relay workspace has several enhancements and requires firmware revision 10 which is included:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode Selection</td>
<td>The Mode Selection function is used to energize one of its outputs when the associated input goes active.</td>
</tr>
<tr>
<td>Status In</td>
<td>The Status In function is used to monitor the fault statuses for Safety Monitoring Functions and Safety Output Functions or to monitor the reset-required statuses for Safety Output Functions.</td>
</tr>
<tr>
<td>Status Out</td>
<td>The Status Out function is used to associate Status-Safety Monitoring Functions with outputs.</td>
</tr>
<tr>
<td>Lock Control</td>
<td>The Lock Control function is used to issue an unlock request to a safety device.</td>
</tr>
<tr>
<td>Tooltips</td>
<td>A Tooltip with a message appears in the Safety Logic Editor if a fault occurs in a Safety Relay function.</td>
</tr>
<tr>
<td>Help context menu</td>
<td>A Help menu is available for Safety Relay functions in the Safety Logic Editor. To open the Help menu, right-click the function and select Help. The Help viewer opens and shows the content for the selected function block.</td>
</tr>
</tbody>
</table>
PanelView800 - Enhancements

The PanelView 800 enhancements:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelView 800 Tags</td>
<td>The Micro800 Cross Reference Browser was enhanced to include PanelView 800 tags. The PanelView 800 tags are listed as variables in the Cross Reference Browser.</td>
</tr>
<tr>
<td>CompactLogix L1 Connectivity</td>
<td>PanelView 800 firmware release 3.011 and later supports connectivity to CompactLogix 5370 L1 controllers. Communications configuration protocol should be set to Ethernet</td>
</tr>
<tr>
<td>Improved CIP download</td>
<td>PanelView 800 firmware release 3.011 and later has a more streamlined workflow when unloading running applications in the terminal.</td>
</tr>
</tbody>
</table>

System Requirements

Hardware Requirements

To use this release of Connected Components Workbench effectively, your personal computer should meet the following minimum hardware requirements:

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum Requirement</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Pentium 4 2.8GHz or equivalent</td>
<td>Intel Core i5 2.4GHz or equivalent</td>
</tr>
<tr>
<td>RAM memory</td>
<td>2 GB</td>
<td>8 GB or more</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>10 GB free</td>
<td>10 GB free or more</td>
</tr>
<tr>
<td>Optical drive</td>
<td>DVD-ROM</td>
<td>DVD-ROM</td>
</tr>
<tr>
<td>Pointing device</td>
<td>Any Microsoft Windows®-compatible pointing device</td>
<td>Any Microsoft Windows®-compatible pointing device</td>
</tr>
</tbody>
</table>
Operating System Requirements

This release is supported on the following operating systems:

- Microsoft Windows 7 SP1 (32-bit and 64-bit)
- Microsoft Windows 8 and 8.1 (32-bit and 64-bit)
- Microsoft Windows Server 2008 R2 SP1
- Microsoft Windows Server 2012
- Microsoft Windows Server 2012 R2

Security requirements

Connected Components Workbench and its included software require running system services and network access to communicate with controllers, drives, graphic terminals, and other devices. You may need to enable system services or configure firewall rules in order for Connected Components Workbench to function properly.

For a list of software installed with Connected Components Workbench, see "Components installed with Connected Components Workbench" in Installation and Upgrades.

For a list of services that require network access, as well as detailed information on security concerns, see Knowledgebase Answer 609492, "Security considerations when using Rockwell Automation Software Products."
Micro800 Firmware Revision Compatibility

The following table identifies the major firmware revisions that can be used for each of the Micro800 controller types.

<table>
<thead>
<tr>
<th>Controller Type</th>
<th>Major Firmware Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Micro810</td>
<td>1.xxx, 2.xxx, and 7.xxx</td>
</tr>
<tr>
<td>Micro820</td>
<td>6.xxx, 7.xxx, 8.xxx, and 9.xxx</td>
</tr>
<tr>
<td>Micro830</td>
<td>1.xxx, 2.xxx, 4.xxx, 6.xxx, 7.xxx, 8.xxx, and 9.xxx</td>
</tr>
<tr>
<td>Micro850</td>
<td>2.xxx, 4.xxx, 6.xxx, 7.xxx, 8.xxx, and 9.xxx</td>
</tr>
</tbody>
</table>

For the latest information about software platform support and compatibility, software and firmware updates, visit the Product Compatibility and Download Center.

Go to http://www.rockwellautomation.com/rockwellautomation/support/pcdc.page.

Rockwell Automation® Software Compatibility

This release has been successfully tested with the Rockwell Automation software products listed in the following table.

<table>
<thead>
<tr>
<th>Software</th>
<th>Tested Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSLinx® Classic</td>
<td>V3.74.00</td>
</tr>
<tr>
<td>ControlFLASH™</td>
<td>V12.00.01</td>
</tr>
</tbody>
</table>

RSLinx Classic Compatibility Requirements

RSLinx Classic v3.74.00, which is included with Connected Components Workbench, is not compatible with the following product versions:

- RSNetWorx v9.00 or earlier.
- DeviceNet Tag Generator v11.0 or earlier.

RSNetWorx Compatibility Requirements

If an incompatible version of RSNetWorx (v9.00 or earlier) is detected during installation, the installation will not continue. You will need to either remove the incompatible version or upgrade RSNetWorx v21.00 or later.

RSNetWorx Compatibility Product Notice

For RSNetWorx (v9.00 or earlier) and Prior Incompatibility with Rockwell Automation Software Products is available from the Rockwell Automation Support Center, as Product Notice ID 56697.
Upgrading RSNetWorx

If you are under a current technical support contract, you may download RSNetWorx v21 from the Rockwell Automation Compatibility and Download Center.

To download RSNetWorx

1. Click the Download Software Updates link and enter your Rockwell Automation Member identification.
2. Enter your Company Name and the Software Serial Number for your current RSNetWorx.
3. Follow the instructions to download and install the updated software product.

If you are not under a current technical support contract, you may purchase an update for RSNetWorx by contact Rockwell Automation sales.

Note: RSNetWorx v21.00 is also available in Studio Professional v21.00.

Working with Projects in Connected Components Workbench

Using existing projects in current release

You can open a project created in a previous release without updating the controller firmware or performing a manual project conversion. However, if you want to use the most current features, you must convert the project using the Change Controller feature. If you do not update the controller revision to the latest, new features will not be available. See Convert a project to the current release section in Installation and Upgrades for more information.

Using different account types

When you create new projects or open existing projects, we recommend you do not use the default Guest user account, and that you do use the same type of account you used when you installed Connected Components Workbench. That is, if you were logged in under an administrator account when you installed CCW, you should log in with an account that has administrator privileges when you use Connected Components Workbench.

To change to an administrator account

1. Navigate to: \Program Files > Rockwell Automation > CCW.
2. Right-click CCW.Shell.exe, select Run as, select Administrator user.
3. Click OK.
To create a new Guest user account

1. Open the New User dialog box:
2. Right-click Users and then select New User.
3. In the New User dialog box, enter the new user name and password and click Create.
4. Click Groups to display the group types.
5. Double-click the Guests group to open the Guest Properties dialog box.
6. Click Add and enter the location and name information for the new user you created in previous steps.
7. Click Check Names to verify the information is correct.
8. Click OK to add the new guest user to the Guest group.
9. Click OK to close the dialog box.

Localized versions of Connected Components Workbench

Some features within CCW may only appear in English, even in the localized versions of the software. For example, the DeviceLogix editor, which is used for PowerFlex drives is only available in English.

Installation and Upgrades

Installing Connected Components Workbench

Follow these steps to install Connected Components Workbench

1. Verify your system meets or exceeds the System Requirements.
2. Download the current version of Connected Components Workbench (Standard or Developer Edition).
3. Launch Setup.exe.
4. By default, all products are selected and install with CCW. To remove a product for the current install, clear the product’s check box.
5. Follow the prompts in the Connected Workbench Setup window.
   Note: Connected Components Workbench determines the components to upgrade and install. If there is a reboot requirement, reboot the operating system so the install can complete successfully.
6. (optional) If installing the Developer Edition, enter your serial number into the installer when prompted.

7. When the installation is complete, click **Finish**.

**Tip:** Some Microsoft components may require a restart before the full CCW installation is complete. If Connected Components Workbench does not install completely, restart the computer and then reinstall CCW. After the Connected Components Workbench installation completes, the computer background will return to its default setting.

**Current Program Updater**

In order for the Current Program Updater to work seamlessly, you must invoke the Current Program Updater software at least once after installation and configure it.

**Follow these steps to configure the Current Program Updater**

If your user account is an administrator account:

1. Close this instance of Current Program Updater, right-click the Current Program Updater shortcut and choose Run as administrator.

2. Run the updater as you normally would and Current Program Updater will automatically correct any missing permissions. The next time you run it, you may revert back to running the standard way.

If your user account is a standard account (you will require the assistance of an IT person with administrator login credentials):

1. Close this instance of Current Program Updater, right-click the Current Program Updater shortcut and choose Run as administrator.

2. Have your IT contact enter the administrator password.

3. Run the updater as you normally would and Current Program Updater will automatically correct any missing permissions. The next time you run it, you may revert back to running the standard way.

**Note:** The Current Program Updater only updates permissions on directories of applications that are being updated. This will not affect applications not related to Current Program Updater.
Upgrading to the current release of Connected Components Workbench

Follow these steps to upgrade a previous release of Connected Components Workbench to the current release. If a required component

Before you begin

- Record device configuration information related to Modbus mapping, Interrupts, Serial Port settings and Embedded I/O for all existing projects.

To upgrade to the current version of Connected Components Workbench

1. Download the current version of Connected Components Workbench (Standard or Developer Edition).
2. Uninstall the previous version of Connected Components Workbench from your computer.
3. Launch Setup.exe.
4. Follow the prompts in the Connected Components Workbench Setup window.
5. (optional) If installing the Developer Edition, enter your serial number into the installer when prompted. **Note:** Connected Components Workbench determines the correct components to upgrade.
6. Click **Finish** when the upgrade is complete.
7. If you want to use the most current features on projects created in previous versions of CCW, follow the steps in **Convert a project to the current release**.

Opening existing projects

An existing project that is converted to the current release, or opened and saved in the current release, or downloaded to a Micro800 controller cannot be opened in a previous release. If a project is shared, all users must upgrade to the current release of Connected Components Workbench to continue using the project.

Converting an existing project to the current release

When you open a project that was created in a previous release of Connected Components Workbench, the project database is automatically updated to the current release. However, to use new features associated with the current release, you must use the **Change Controller** feature to update the controller firmware revision. For the specific firmware revisions that can be used for each controller type, see the **Micro800 firmware revision compatibility** section in **System Requirements**.
To convert an existing project

1. Open the existing project in the current version of Connected Components Workbench.

2. Recommendation: Record device configuration information related to Modbus mapping, Interrupts, Serial Port settings and Embedded I/O for the project.

3. Use the Change Controller feature to update the controller firmware revision.

4. If necessary, manually reconfigure Modbus mapping, Interrupts, Serial Port settings and Embedded I/O for the project.

Note: Modbus mapping information is stored in the MbSrvConf.XML file located in the CCW project structure: CCW\<projectname>\controller\controller and can be copied from the original project to the newer one.

Removing Connected Components Workbench

Follow these steps to remove Connected Components Workbench only. For other components, remove each component separately after removing Connected Components Workbench.

1. Uninstall Connected Components Workbench from your computer. By default, the following components are removed also:

   - Drives
   - Graphic Terminals
   - Safety
   - Controller

2. Verify Connected Components Workbench does not appear in the list of installed programs.

3. Remove other components as necessary. See Components installed with Connected Components Workbench.
Installing a different language edition of Connected Components Workbench

To install a different language edition of Connected Components Workbench

**Important:** Remove CCW before remove Microsoft Visual Studio Shell or you will not be able to remove CCW.

1. Uninstall the previous language edition of Connected Components Workbench from your computer.
2. Verify Connected Components Workbench does not appear in the list of installed programs.
4. Download the desired language version of Connected Components Workbench (Standard or Developer Edition).
5. Launch Setup.exe to begin installing the desired language version of Connected Components Workbench and Microsoft Visual Studio Shell.
6. Follow the prompts in the Connected Components Workbench Setup window.
7. When the installation is complete, click Finish.

Installing newest PanelView 800 firmware

PanelView 800 DesignStation, which can be used to create, configure, and monitor Graphic Terminal devices, is installed with Connected Components Workbench and can be accessed from the Project Organizer after adding a Graphic Terminal device.

An upgrade of your Panel View 800 firmware is not required, but is recommended, and may be needed for newer features. You can download the latest PanelView 800 firmware from the Rockwell Automation Graphics Terminals Website.
**Components installed with Connected Components Workbench**

The following additional components are installed with Connected Components Workbench Standard and Developer Editions. However, these components will not be removed if you uninstall Connected Components Workbench because other software may be using them.

<table>
<thead>
<tr>
<th>Type</th>
<th>Includes</th>
</tr>
</thead>
</table>
| Rockwell Automation         | • ControlFlash™ 12.00.01  
• Rockwell Windows Firewall Configuration Utility 1.00  
• Rockwell Automation USBCIP Driver Package (x86) 3.18.06 or  
• Rockwell Automation Driver Package (x64) v1.1.18  
• RSLinx Classic 3.74.00 CPR 9 SR 7.4  
• Current Program Updater     |
| Microsoft .NET Framework    | • Microsoft .NET Framework 4.5.1                                        |
| Microsoft Visual Studio® 2013 Isolated Shell - ENU | • Microsoft .NET Framework 4.5 Multi-Targeting Pack  
• Microsoft .NET Framework 4.5 SDK  
• Microsoft .NET Framework 4.5.1 Multi-Targeting Pack  
• Microsoft .NET Framework 4.5.1 Multi-Targeting Pack (ENU)  
• Microsoft .NET Framework 4.5.1 SDK  
• Microsoft Help Viewer 2.1  
• Microsoft SQL Server 2012 Management Objects  
• Microsoft Visual Studio 2013 Shell (Isolated) |
| Microsoft - other           | • MSXML 4.0 Parser and SDK  
• Microsoft SQL Server Compact (x86) ENU or  
• Microsoft SQL Server Compact (x64) ENU 4.0.8482.1 |
| Other                       | • OPC Core Components Redistributable (x86) 101.2 or  
• OPC Core Components Redistributable (x64) 101.2  
• Adobe Reader® 11.0          |

**Connected Components Workbench Developer Edition Only**

| FactoryTalk®                  | • FactoryTalk Activation Manager v3.62.01 (CPR 9 SR 6)  
• FactoryTalk Diagnostics v2.61.00 (CPR 9 SR 6.1) |
Helpful Resources

User assistance available in the application

Use the Help menu to access online information such as user manuals, user forums, support e-mail, and the Rockwell Automation Knowledgebase.

Press F1 to open a topic specific to the user interface item you have selected.

Tips:
- If the user interface item does not display a topic, click Help > Search and enter a subject in the search box to locate a relevant topic in the help.
- Connected Components Workbench uses local help only.

Help Viewer 2.1 is the container for the CCW 9.00 Help

The Help Viewer 2.1 Filter has been designed to keep the search list compact and manageable. Titles appear in the filtered TOC list only if they contain the root of the term used in the filter and the empty TOC levels are collapsed with an ellipsis (...). For example, if you specify "troubleshooting" as a filter, only titles that contain "troubleshoot" or "troubleshooting" appear. Nodes whose titles do not contain the term are collapsed to a single node with an ellipsis (...).

In the filtered TOC you can do the following:
- Mouse over an ellipsis (...) in the filtered TOC to show the corresponding topic title in a popup window.
- Close the Filter to show the unfiltered TOC.

Internet Explorer security settings

When Connected Components Workbench is installed on PCs running Windows Server 2008 and Windows Server 2012, you might need to adjust the browser security settings to view CCW Help in Help Viewer 2.1.

1. Open Internet Explorer.
2. On the Tools menu, click Internet Options, then select the Security (Tab).
3. Select the Internet zone, then click Custom level and change the following settings:
   - Enable MIME Sniffing – set to Enable
   - Active scripting – set to Enable
4. For PCs running non-server operating systems, change the Internet zone security level to Medium.
5. Launch Connected Components Workbench and verify the help shows correctly in Help Viewer 2.1.
Accessing Rockwell Automation support websites

With the exception of manuals, you must register (Become a Member) to access, free of charge, Rockwell Automation support websites. Go to: http://ab.rockwellautomation.com.

Rockwell Automation Knowledgebase

The Rockwell Automation Knowledgebase contains product notices, Technotes, and FAQs that you can access after you log into the Knowledgebase.

To access articles from the Rockwell Automation Knowledgebase

2. Log in.
3. Enter the Answer ID (for example: 116930) in the Search box.

Knowledgebase articles

<table>
<thead>
<tr>
<th>Article</th>
<th>ID number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Micro800 basic FAQ</td>
<td>Answer ID 116930</td>
</tr>
<tr>
<td>Micro800 extended technical FAQ</td>
<td>Answer ID 1188115</td>
</tr>
<tr>
<td>Security considerations when using Rockwell Automation Software Products</td>
<td>Answer ID 609492</td>
</tr>
<tr>
<td>TCP and UDP ports used by Rockwell Automation Products</td>
<td>Answer ID 29402</td>
</tr>
<tr>
<td>RSNetWorx v11 and Prior Incompatibility with Rockwell Automation Software Products</td>
<td>Product Notice ID 56697</td>
</tr>
</tbody>
</table>

Rockwell Automation Literature Library

You can view or download publications from the Rockwell Automation Literature Library, including the following:

- PanelView 800 DesignStation Release Notes (2711C-RN010-EN-E)
- Kinetix 3 user manuals
- Kinetix Rotary Motion Specifications
- Safety relay user manual
- Non-English language versions of user manuals
To access manuals from the Rockwell Automation Literature Library

2. Click Advanced Search.
3. Enter the product information and other search criteria, and click Search.

To access the non-English language versions of user manuals

2. Select the language from the Publication Language drop-down box (right corner).
3. Enter the full or partial device catalog number in the Search box. For example, enter 2080-LC30 to view Micro830 user manuals.

Important Considerations

Security considerations

For security purposes, install Connected Components Workbench on the latest operating system version supported by Connected Components Workbench per the Connected Components Workbench release notes.

Keep the operating system up to date with service packs and Windows updates.

File extensions created by Connected Components Workbench and location of product-managed files

Connected Components Workbench creates and uses the file extension .ccwsln for user-created projects.

By default, the product-managed files are saved to:

C:\Users\<user>\Documents\CC\Project\<Project #>.ccwsln

Firewall rules

Connected Components Workbench does not require endpoint firewall rules because it is not a server product that allows remote clients.
For more information on security considerations when using Rockwell Automation products, including:

- File extensions created by Rockwell Automation software, and firewall rules, see Rockwell Automation Knowledgebase Answer ID 609492.
- TCP/UDP ports used by Rockwell Automation products, see Rockwell Automation Knowledgebase Answer ID 29402.

**IEC-61131 standards**

Connected Components Workbench adheres to the IEC-61131 standards for programming. If you do not have previous experience with IEC-style concepts and programming, we recommend you view the 'Getting Started with Developing' section in the software help. The topics, which step you through the process of creating a basic sample application, are intended to introduce you to IEC-style programming within the Connected Components Workbench environment.

**Programming, configuring and debugging**

- Unless specifically stated in user documentation, do *not* change attributes in Property dialogs for Micro800 controllers.
- Some features that should be disabled appear available while the debugger is operating. A small subset of these features may cause Connected Components Workbench to close unexpectedly. If you recently started the debugger, ensure you stop it before performing other software operations.
- Connected Components Workbench does not automatically update every instance of a changed UDFB (User-Defined Function Blocks) referenced in an existing program. If you change a UDFB definition, you should update each individual instance of the UDFB. To do so, locate each instance, double-click it, and then build the program.

**Uploading, download and building**

- When you build a controller project with Connected Components Workbench, all changes are immediately committed to your hard drive or to your designated storage device so you will not be able to undo any changes. To ensure you can return your project to a prior state, save the project using a different name after making changes.
- If the Upload or Download options are not available in the Device Configuration toolbar, select the Micro800 controller from the Project Organizer, and then click Upload or Download. If this does not activate upload/download, rebuild the project by right-clicking the controller in the Project Organizer and selecting Build.
### Resolved Anomalies

This section identifies anomalies that have been resolved since the last release of Connected Components Workbench.

#### Resolved projects, documentation and tools anomalies

When you add a Block element to a Program (POU) in the non-English versions of Connected Components Workbench, rename the POU in the Project Organizer, the renamed program Saves or Builds without error. [APBC00013784]

#### Resolved controllers and devices anomalies

When you launch CCW and discover the project from the Micro800 controller flashed with 8.11.02 firmware, the Plug-in module and the Expansion module information uploads correctly. [APBC00024587]

The PanelView Component correctly displays integer decimal values in Spanish that were created while the regional setting is English. [APBC00005484] [APBC00005485]

#### Resolved data types and variables anomalies

The following data types work as expected when constant values are used in arithmetic expressions:

- DWORD
- LWORD
- INT
- SINT
- UDINT
- ULINT
  [APBC00021989]

Variables with an array data type display the correct values when monitored. [APBC00018556]

#### Resolved instruction block anomalies

The Search option used to find and replace content in user-defined function block code replaces content defined in the Search. [APBC00020636]

When monitoring a COP instruction block instance, the Scr and Dest input values update. [APBC00014533]
Known Anomalies

This section describes known anomalies in this release and, if needed, provides workarounds.

Installation

Connected Components Workbench installs two folders named CCW under "Libraries > Documents". The duplicate folder name is inaccurate because the folders contain different files. One folder contains saved project files and the other contains Sample Project files. [APBC00021599]

If the My Documents folder is mapped to a network drive and the user installing Connected Components Workbench does not have full permissions to the network folder the following error might appear: "Error 1325 [FolderName] is not a valid short file name. [APBC00021544]

Convert existing projects to the current release

Memory allocation is not updated when you build a CCW R7 project in CCW R8. For large projects this could result in an error such as the one shown here: "The size of embedded file for device Micro850 is too large: 137529 > 133120." [APBC00024812]

Workaround: Use the Change Controller method to change the controller type and then build the project to updates the memory allocation. Use the Change Controller method to revert back to the original controller type and build the project again. The build is successful.

During the Reset VSS Setting process, there are two error messages that should not occur. The errors do not affect the reset process and should be ignored.

- Error 1: Failed to export settings for ‘#20133’
- Error 2: Failed to export settings for ‘#205’
[APBC00024828]

Projects, documentation and tools

In Connected Components Workbench 9.0, when you Discover a project and the message, “The current project does not match the content in the connected controller.” appears, click OK to close the message dialog box. If you try and connect to the controller again CCW allows the connection to the controller to proceed when the connection should fail due to the mismatch between the project in the controller and the CCW project. [APBC00026004]

Workaround: If this occurs, disconnect from the controller, build the program, and try to connect to project again. The connection fails as expected.

In Connected Components Workbench 8.0 and 9.0 Developer Editions, when multiple sessions of CCW are open, building two projects at the same time is not recommended and may cause build errors. [APBC00024050]

Workaround: If a build error occurs, try rebuilding one project at a time.

The first time you download a project with a scanner address change and then open the Communication Diagnostic View for DeviceNet, the scanner address incorrectly shows the default value of 0. [APBC00023419]

Workaround: To show the correct scanner address, select a different Communication type in the Communication Diagnostic View such as Ethernet, then select DeviceNet again.

If, after you install the English version of CCW, you change the language format text to the Turkish language, you may receive unexpected results including the following:

- Broken help links when you reopen a project.
- Non-English characters that display when you debug your program.
- Inability to use the filter feature in a language editor for certain characters.
- Failed build because the project name or folder contains invalid characters. [APBC00016210] [APBC00015858]

If, while using the English version of CCW, you enter non-English characters in a string variable, the characters may not display properly after you save, close and then reopen the project. [APBC00015937]

Workaround: In your operating system, select the language version of non-Unicode programs that will be used in the Language for non-Unicode programs.

Rockwell Automation Publication CC-RN001J-EN-E – November 2015
If you open multiple projects on a network drive using File > Recent Projects, and then exit or close CCW, the application may not close immediately. [APBC00014847]

Content for the instruction block tooltips appear in English in the non-English versions of Connected Components Workbench. [APBC00013270]

The labels for Browse and No header or footer in the Document Generator for the non-English versions of Connected Components Workbench may be truncated. For example, the label ‘Durchsuchen’ appears as ‘Durchsuche’. [APBC00013944]

The Quick Find and Quick Replace features (Ctrl+F and Ctrl+H) are limited to logic editor. They do not work with devices, global variables or UDFBs. Additionally, Quick Find has the following limitations:

- It does not find any items when the Look In selection is Current Project or Entire Solution.
- It may not locate all instruction blocks within all containers in the project.
- It does not find all instances of the same Array element variable in all the programs within a project.

Workaround: To find items in the project, click Edit > Find and Replace > Quick Find, and click Current Document or All Open Documents in the Look In drop-down box.

The Quick Find and Quick Replace features will be enhanced in a future release. [APBC00011079] [APBC00011080] [APBC00011462]

If the appearance settings in your operating system uses a high-contrast color theme, some workspace elements will display incorrectly. For example, ladder rungs and connectors in the program editors, graphics and toolbar in the Controller Details view, and the Device Toolbox. [APBC00011574] [APBC00011577] [APBC00011578]

Workaround: Do not use a high-contrast color scheme.

Controllers and devices

If the Micro800 controller has 9.0, 8.0, 7.0, or pre-6.0 firmware and is password protected by 9.0, 8.0, or 7.0, you cannot connect to the controller with a Connected Components Workbench project that is 6.0 or lower. Access is denied even when the correct password is provided. [APBC00022232]

Workaround: Clear the controller’s password by CCW 9.0, 8.0, or 7.0

If the Micro800 controller has 9.0, 8.0, 7.0 or pre-6.0 firmware and is password protected by CCW6.0 or lower, you cannot connect to the controller with a Connected Components Workbench Version that is 9.0, 8.0 or 7.0. Access is denied even when the correct password is provided.

Workaround: Clear the controller’s password by CCW6.0 or lower.

When you re-launch Connected Components Workbench after an unexpected shut down, the Micro800 controller might be locked and you will be unable to connect to the controller from the Connection Browser. [APBC00021900]

Workaround: The recommended solution to clear the lock on the controller is to restart Windows and the controller.

The second option is to:
1. Terminate CCW.Shell.exe and RA.CCW.CommServer.exe
2. Shutdown RSLogix and restart RSLogix
3. Restart CCW and try to connect to the controller, the connection may still fail.
4. Restart CCW and RSLogix and try again, the connection should be established.

When you configure an Event Input Interrupt (EII), you can specify which input to use from the Configure Event Input Interrupt (EII) dialog box. You cannot, however, specify the edge triggering type (rising or falling edge) from the same dialog box. [APBC00005579]

Workaround: To specify the EII edge triggering type (rising or falling edge), click Embedded I/O in the controller tree and configure the Properties in Input Latch and EII Edge.

In the Variable Editor, when viewing a user-defined function block that contains multiple nested functions or function blocks, the nested variables may not align correctly within the Logical Value column. If you hide the Logical Value column and then show the column, it is moved to the rightmost position in the Variable Editor and the values for the nested variables may not show in the column. [APBC00014339]

If you create a string array using the Global Variables grid, the maximum length is 252 characters. If you create a string array using the Data Types grid, the maximum length is 255 characters. [APBC00010227]

Workaround: Make all string arrays 252 characters or less.

The SAFEBOOL data type appears as an option in the Arrays grid, but SAFEBOOL is not supported by Micro800 controllers. [APBC00010414]

Workaround: Do not select SAFEBOOL as a data type.
The maximum number of words for the `MSG_MODBUS ElementCnt` parameter is 123 even though the `LocalAddr` specifies 125 words. If you use a value of 124 or 125 for the `ElementCnt` you will receive an error indicating a bad MSG file parameter exists. [APBC00003889]

**Workaround:** Verify the `ElementCnt` variable uses a value of 123 words or less.

If you use single quotes in a variable within an array element even when the data type is String, the build may fail. [APBC00011206]

**Workaround:** Do not use single quotes in array element variables.

The allocated memory for a Micro800 controller is not retained on the Memory configuration page after a Controller Change or Export/Import project. [APBC000021196]

The allocated memory value is not retained when you upload. [APBC00021722]

### Data types and variables

User-defined global variables with data types BYTE, WORD, LWORD, and DWORD might display as USINT, UINT, ULINT, and UDINT data types on LCD displays for Micro800 controllers. [APBC000020820]

Include Logical value upon backup and restore' functionality does not restore the logical value for the following system variables:

- `_SYSVA_KVBCERR`
- `_SYSVA_TCYCYCTIME`
- `_SYSVA_TCYWDG`

[APBC00021350] [APBC00021351]

If you attempt to copy and paste a variable that uses an initial value from one open session of Connected Components Workbench to another open session, you may receive an error message similar to one of the following, and the paste operation will not be successful.

- “Warning: The variable you are pasting having the data type ‘aa’ is non-existent in the current project. Therefore, the variable shall be created as an undefined type.
- The importation of the symbol Controller.Micro850.Micro850.Prog1.v1 was unable to set the field TextInitialValue(1.65) -> Exception Message: The value does not match the format of the data type.”

[APBC00018350]

**Workaround:** Copy all data type definitions to the project before you copy the variable.

In this release, some of the vendor specific instruction blocks and other program elements have not been identified as reserved words. When you name a variable, CCW may allow you to name a variable the same as an instruction block even though it should not be allowed. When you attempt to build a program with duplicate names, the error message will identify the instruction name as the problem rather than the user variable. [APBC00017881]

If you name a variable the same as an existing program name, you will receive an error when you attempt to build the project. You can disregard the error message as a program and a variable can use the same name since they are different object types. Duplicate names in this situation will not prevent the project from building. [APBC00018410]

If you attempt to set the Logical Value for a sub-element of a data type that contains a nested array/structure, you may need to click more than once to enable the selection. [APBC00017133]

### Instruction blocks

If you import a UDFB into a password-protected program that already contains an instance of the same UDFB, you will not be prompted to enter the program password even though the UDFB instance in the program will be replaced by the newly imported UDFB instance. [APBC00018245]

If you rename a user-defined function block instance that is referenced in a program and then build the controller project, the following error message appears:

“A function, function block, or operator is not defined”.

UDFB instances must have the same definition to successfully build the controller project. [APBC00016939]

**Workaround:** Open the program and reselect the UDFB.
### Programs

In CCW 9.0, if you open the Variables grid and right-click an array element variable that is referenced in a program, then click the **Cross Reference Browser**, nothing happens. The **Cross Reference Browser** should open and display the selected array element (variable).  

[APBC00027347]

**Workaround:** To open the **Cross Reference Browser** and show the variable, right-click the array variable, not one of the array elements in Variable grid.

In CCW 9.0 the Cross Reference Browser shows the wrong datatype when searching for a bit in a Structured Text program.  

[APBC00027304]

In CCW 9.0 the Cross Reference Browser cannot reference variables defined in Structured Text programs when the expression contains one of the following: "+", "-", sub-array, and there is no blank space between the variable and constant.  

[APBC00027420]

For example the following Structured Text expression would not show in the Cross Reference Browser:  

\[ a := \text{usint1}[1]+1 \]

**Workaround:** To resolve the Structured Text issue change the expression to include blanks spaces between the variable and constant.

For example:  

\[ a := \text{usint1}[1] + 1 \]

During **Run Mode Change** after adding or deleting a POU in a project that has UDFBs, if you **Test changes** then **Discard unaccepted changes**, an error may occur with the message, "Unable to download the reverted project to controller." followed by an exception "The user program is incompatible with the Micro800 controller's firmware revision.".  

[APBC00027421]

**Workaround:** If this occurs, you should click *OK* and go to Program Mode, Disconnect, and then do a full download of the project in order to clear the controller fault and continue monitoring the project.

In Connected Components Workbench 6.0, 7.0, and 9.0, Defined Word, **Const**0 is incompatible with all data types on compare instructions.  

[APBC00022224]

If you use a Remote Desktop Connection to access a CCW program, the font for some of the comments in the program may change and be difficult to read.  

[APBC00017812]

**Workaround:** Double-click the comment to restore the original font.

In Connected Components Workbench 8.0 and 9.0 Developer Editions, when you make changes to your programs using Run Mode Change and then Test, Accept or Undo the changes, these processes may take longer than expected and appear to be non-responsive since there is no progress indicator. This issue will be addressed in a future release.  

[APBC00024020]

In Connected Components Workbench 8.0 and 9.0 Developer Editions, if you open a project from a network folder, enter **Run Mode Change** mode, add or update a program with instructions and variables, then **Test changes**, the following error message may appear: "CCW is not able to download the changes to the controller. To continue, click 'Retry' to download again, or click 'Cancel' to go to Run Mode Change Mode."  

[APBC00024596]  

[APBC00024825]

**Workaround:** If you encounter this error message and your project file is on the network or you uploaded a project file from the controller that was downloaded from a PC with a different clock setting, copy the project file to your local drive before entering **Run Mode Change** mode.

In Connected Components Workbench 8.0 and 9.0 Developer Editions, if while in **Run Mode Change** mode and during **Test changes**, the following error occurs: ‘CCW.Shell has encountered a problem.’ Then restart CCW, re-open the project, and re-connect to continue working.  

[APBC00024572]
Import and export

In CCW 9.0, if you add a Global variable to the project, export variables to Excel, save and reopen the project, then right-click the Micro800 and select Import > Variables from Excel to open the Variable Export/Import dialog box, the Import button is unavailable. [APBC00027349]

Workaround: If this occurs, make a change in the CCW project and then reopen the Variable Export/Import dialog box, the Import button is available.

In the Import and Export Setting Wizard, if you reset all settings and select the option, No, just reset settings, overwriting my current settings, some items may not appear in the File and Help menus as expected. [APBC00015185]

Workaround: If this happens follow these steps:
1. Save your project.
2. Close, and reopen Connected Components Workbench to display all the menu items.

If you import a file containing Toolbox settings using the Import and Export Setting Wizard and the project contains an LD program, the LD Toolbox may not show its controls after the import. Instead, the LD Toolbox will show the text, "There are no usable controls in this group. Drag an item onto this text to add it to the toolbox." [APBC00020531]

Workaround: Right-click the Toolbox and select "Reset Toolbox".

If, while importing variables into a password-protected POU, you click Cancel in the Enter Password dialog box, the import will be canceled, which is expected behavior. However, you still may receive an Import was successful message in the output window, which is incorrect. [APBC00016089]

If you try to Import a Micro800 program that contains a password and the program is not compatible with the version of Connect Components Workbench that you are using, the Password required dialog box appears. After you enter the password, the Unable to start importing dialog appears. [APBC00014022]

If you import a UDFB program into a project that contains a user-defined data structure or array with the same name as the UDFB, the project build will fail, which is expected behavior. However, the error message may indicate a FB symbol duplication error, which is incorrect. [APBC00015612]

Build, debug, download and upload

If an upload is performed on a controller that still has an uncommitted change (that is, did not accept or undo from a previous Run Mode Change), then CCW will erroneously connect to the controller after the upload. [APBC00024859]

Workaround: If this occurs, disconnect after the upload, build, and download to synchronize the offline project with the controller.

If you enter Debug mode after running Connected Components Workbench for an extended period of time, a red X may appear in the language editor, and you may receive the following error message: “CCW.shell has encountered a problem. We apologize for the inconvenience. Please tell ISaGRAF about this problem” [APBC00018407]

Workaround: If this occurs, close the language editor, verify you are in Debug mode, and then reopen the language editor.

Note: Any message that identifies ISaGRAF as a contact should actually identify Rockwell Automation as the contact. See Support Information for contact information.

If you attempt to build a project that has an invalid Motion Engine Execution Time, you will receive a build error, which is expected behavior. If you then delete the Motion Axis without first correcting the Engine Execution Time and build the project again, the build will still fail. Note: When you enter an invalid value, the field is outlined in red indicating an error. [APBC00011576]

Workaround: Follow these steps to resolve the error:
1. Add an Axis, and enter a valid Motion Engine Execution Time.
2. Save the project.
3. Delete the Axis and then save the project again.
4. Re-build the project.

If you change the interrupt assigned to a program, Connected Components Workbench does not calculate a new CRC for the program. When you attempt to debug a program where only the interrupt has changed, Connected Components Workbench displays a project contents mismatch error instead of a CRC mismatch error. [APBC00021071]
Complex variables, function blocks and instructions that contain members with initial values do not download their logical values to the controller. The following instructions contain read-only initial values and are affected by this anomaly:

- AWA
- AWT
- COP
- HSC
- IPIDCONTROLLER
- MSG_CIPGENERIC
- MSG_CIPSYMBOLIC
- MSG_MODBUS
- MSG_MODBUS2
- PLUGIN_READ
- PLUGIN_WRITE

If you download a project to a controller, then upload the project to a computer where the date and time is prior to the date and time on the first computer, the second computer cannot Debug or Download to the controller. [APBC00021719]

**Workaround:** Follow one of the following steps to resolve the error:

- Set the date and time of the second computer to be equal to or later than the first computer.
- On the first computer, export the project to a compressed file, then import the project on the second computer.

Restore from memory and Load always functionality are contradictory. When a controller program in Connected Components Workbench is not password protected and Memory module program is password protected, the 'Restore from Memory Module' button is unavailable because of a password mismatch. However, if you power cycle the controller and Load always is enabled for the controller, the program is transferred to the controller. [APBC00021421]

---

**Application Notes**

**Maximum number of parameters for a UDFB**

If the project contains a user-defined function block (UDFB) with too many total parameters, you might receive a build error even though the total number of input and output parameters seems within range. This can happen because the UDFB local variables are included in the total. Limit the total number of parameters for each UDFB to a total of 128.

**Modifying existing UDFBs**

Connected Components Workbench does not automatically update the instances of the modified UDFBs referenced in existing programs. To update every instance of the UDFB, search for it and update each one manually.

**MOV instruction and Assignment operator**

The MOV instruction displays in the Block Selector when it is launched from a LD POU or a FBD POU, but it does not display in a STPOU. ST programs use the “=” assignment operator instead of the MOV function. [APBC00014308]
Connecting to a Micro800 controller on a virtual machine

If you install RSLinx Classic on a virtual machine (for example, VMware), make sure to disable RSLinx Classic on the host computer before you plug the USB cable that is attached to your Micro800 controller into the host computer. If you ignore this step, the host computer will obtain the driver for the Micro800 controller, and the virtual machine may not be able to detect the Micro800 controller.

Connecting to a Device using Ethernet

Using the default EtherNet/IP driver to connect to a device

If you use Ethernet instead of a USB to connect to the controller, the EtherNet/IP driver is installed by default in RSLinx and you can connect to devices which are on the same subnet as the PC. If a DHCP server is available, in most cases your computer and the device (such as, Micro850 controller which defaults to DHCP) will be assigned IP addresses that will allow them to communicate using this EtherNet/IP driver. The EtherNet/IP driver will browse for all devices on the subnet.

In cases where the device is not on the same subnet as the PC or you do not wish to view all devices on the subnet, it is recommended to install the Ethernet Devices driver which requires manually entering the IP address of the device.

To add the Ethernet Devices driver to connect to a device

Follow these steps to add the Ethernet Devices driver. This driver has the advantage of allowing to select which IP addresses to browse but each IP address must be manually entered.

Note: Be sure to select the correct port (it may not be the Windows default).

1. Click Communications > Configure to open the Configure Drivers dialog box.
2. In Available Driver Types, select Ethernet Devices.
3. Click Add New, and type a name for the driver or accept the default name.
4. If prompted, enter the Ethernet adapter selection. Be sure to select the correct port (it may not be the Windows default).
5. For each device enter the IP address (or Host Name if DNS is supported) under Host Name. It is recommended to append ":EIP" to the IP address for better performance by avoiding the older CSPv4 port 2222. Click Add New as necessary. Click OK, then Close when finished.
6. For the device, click Connect to open the Connection Browser.
7. Expand the Ethernet Devices driver you previously added.
8. Select the controller that you want to connect to from your project, then click OK.
Connected Components Workbench sample projects

This release includes several Micro800 controller sample projects that are installed with Connected Components Workbench in one of the following folders.

\Users\current user\Documents\CCW\Sample Projects

VMware compatibility

Compatibility with VMware has not been formally tested, but it has been used extensively with Connected Components Workbench.

- If you experience poor performance using VMware with a Window 7 guest, you may need to upgrade VMware or run Connected Components Workbench on the host operating system. Connected Components Workbench and other software may try to access the networks, to ensure optimal system performance, you may need to disable network adapters.

- If you use Connected Components Workbench with VMware, you may have to manually connect USB devices. When a virtual machine is running, its window is the active window and a USB device is plugged into the host computer, the device automatically connects to the guest instead of the host. This autoconnect feature can be disabled in the USB Controller panel of the virtual machine settings editor (VM > Settings). If all of the virtual machine’s USB ports are already occupied when it is trying to connect automatically to a new device, a dialog box gives you a choice: you can either disconnect one of the existing USB devices to free its port or ignore the new device, allowing the device to connect to the host.

Manually connecting a virtual machine to a USB device

- Choose VM > Removable Devices to connect specific USB devices to your virtual machine. If the physical USB devices are connected to the host computer through a hub, the virtual machine sees only the USB devices, not the hub.

- There is a menu item for each of the USB ports. Move the mouse over one of these items to see a cascading menu of devices that are plugged into your host computer and available for use. To connect a device to the virtual machine, click its name.

- If a device is already connected to that port, click the name of a new device to release the first device and connect the new one.

- To release a connected device, click None on the cascading menu for the port to which it is connected.

- If you physically plug a new device into the host computer and the autoconnect feature does not connect it to a virtual machine, the device is initially connected to the host. Its name is also added to the VM > Removable Devices menu so you can connect it to the virtual machine manually.